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CristalX

[image: badge] [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master] [image: badge] [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master?filepath=notebooks%2Fexample_application.ipynb] [image: BCH  compliance] [https://bettercodehub.com/] [image: Documentation Status] [https://cristalx.readthedocs.io/en/latest/?badge=latest] [image: Join the chat at https://gitter.im/Grain-Segmentation/community] [https://gitter.im/CristalX-community/community?utm_source=badge&utm_medium=badge&utm_campaign=pr-badge&utm_content=badge]

Identification of individual grains in microscopic images

CristalX is a Python package that helps in the analysis of polycrystalline microstructures. Its name originates from the French word ‘cristal’, corresponding to the English word ‘crystal’.


Features


	Image segmentation to identify the grains in a microstructure


	Analysis tools for the segmented image


	Explicit geometrical representation of the grains


	Interacting with meshes created on the microstructure


	Mapping fields between a mesh and the grid of DIC measurements


	Simulation tools for the inverse problem arising from a combined numerical-experimental method (in progress …)


	Visualization and data exchange







Getting help


	Read the documentation [https://cristalx.readthedocs.io/].


	Check the existing issues [https://github.com/CsatiZoltan/CristalX/issues]. They may already provide an answer to you question.


	Open a new issue [https://github.com/CsatiZoltan/CristalX/issues/new].







Contributing

Read the docs/source/contributing.md file.




Citing CristalX

We have an article freely available on SoftwareX [https://doi.org/10.1016/j.softx.2021.100669], showing the background and the design of CristalX.

When using CristalX in scientific publications, please cite the following paper:


	Csati, Z.; Witz, J.-F.; Magnier, V.; Bartali, A. E.; Limodin, N. & Najjar, D. CristalX: Facilitating simulations for experimentally obtained grain-based microstructures. SoftwareX, 2021, 14, 100669




BibTeX entry:

@Article{Csati2021,
  author    = {Zoltan Csati and Jean-Fran{\c{c}}ois Witz and Vincent Magnier and Ahmed El Bartali and Nathalie Limodin and Denis Najjar},
  journal   = {{SoftwareX}},
  title     = {{CristalX}: {F}acilitating simulations for experimentally obtained grain-based microstructures},
  year      = {2021},
  month     = jun,
  pages     = {100669},
  volume    = {14},
  doi       = {10.1016/j.softx.2021.100669},
}
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Installation

CristalX is easy to install; you can get started in minutes.


Dependencies

CristalX is a written in pure Python, although it relies on packages that use other languages (mostly C and C++). However, it is not a problem from the user’s perspective as no manual compilation is needed. Those who are interested can see the dependencies in the environment.yml file in the root directory.

Whether you install CristalX by conda or try it online, all but one dependency is installed. In a common workflow, that single missing dependency will not affect you. For details, see …




Try it online

If you just want to get a taste of CristalX, you can try it online without installing anything.

Click here [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master] to jump to the root directory. Existing Jupyter notebooks are in the notebooks/ directory. You can modify them and create new ones. If you directly want to open the main tutorial, which describes a real-world application, click here [https://mybinder.org/v2/gh/CsatiZoltan/CristalX/master?filepath=notebooks%2Fexample_application.ipynb].




Install it locally

If you want more control (debugging, inspecting variables, etc.) over CristalX or if you wish to contribute to the project, it is recommended to install it on your machine.


Obtain the source

If you are a user of CristalX, the best is to get the latest release:


	download it from GitHub [https://github.com/CsatiZoltan/CristalX/releases]


	or clone it with Git:

git clone https://github.com/CsatiZoltan/CristalX.git
cd CristalX
git checkout v<version_number>





where <version_number> is the version you want to use. E.g. if you want to use version 1.0.1, you need to type git checkout v1.0.1. See the available tags [https://github.com/CsatiZoltan/CristalX/tags], corresponding to the published releases, for the possibilities.

Note that in this case, you will be in a “detached HEAD” state, meaning that the HEAD does not point to a branch but to the specific tag. Any commit you make in this state will not be associated with a branch. Therefore, if you want to develop or contribute to CristalX, check out the master branch (see the next paragraph).





If you want to develop CristalX or simply want to have access to the latest features, you need to fetch the latest state:


	download it from GitHub [https://github.com/CsatiZoltan/CristalX/archive/master.zip]


	or clone it with Git:

git clone https://github.com/CsatiZoltan/CristalX.git












Install with conda

All you need to have is the conda [https://docs.conda.io/en/latest/] package manager. Open a terminal (or a command prompt if you are under Windows) in the root directory and type

conda env create -f environment.yml





CristalX has been installed to a separate environment, so you can safely work inside it. Activate that environment:

conda activate CristalX





Once you have finished working with CristalX, either close the terminal or type

conda deactivate





to return to your default conda environment.

If you want to uninstall CristalX, make sure that the CristalX conda environment is not active and then

conda env remove -n CristalX





When uninstalled, conda env list will not show it.




Install with pip

If you do not have conda or you prefer pip, you can also install CristalX by typing

pip install -r requirements.txt





assuming that you have Python installed. It is highly recommended that you first create a new virtual environment to make sure you do not break your Python installation. However, an important component of CristalX (functions that rely on PythonOCC) will not be installed if you choose pip. The reason for this is that PythonOCC [https://github.com/tpaviot/pythonocc-core] is not (yet) available on PyPI [https://pypi.org/].
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Documentation

The documentation for CristalX is available both locally and online. It is generated by Sphinx [https://www.sphinx-doc.org] and consists of the code documentation and the various guides (including the one you are currently reading). If you want to extend the documentation, please read the corresponding section in the Developer guide.


Local documentation

It resides in the docs/ directory. Open a terminal there and type make html. The output will be written to docs/build/. Open docs/build/html/index.html to land on the home page of the documentation.




Online documentation

For every push event, the documentation is rebuilt by Read the Docs [https://readthedocs.org/]. The latest HTML version is available on https://cristalx.readthedocs.io/en/latest [https://cristalx.readthedocs.io/en/latest/]. Read the Docs is configured [https://github.com/CsatiZoltan/CristalX/blob/master/.readthedocs.yml] to build a PDF and EPUB output as well. All three formats can be downloaded for offline use if you click on the bottom of the left sidebar. For convenience, here are the direct links: HTML [https://cristalx.readthedocs.io/_/downloads/en/latest/htmlzip/], PDF [https://cristalx.readthedocs.io/_/downloads/en/latest/pdf/], EPUB [https://cristalx.readthedocs.io/_/downloads/en/latest/epub/].




Using the HTML documentation

For browsing on a computer, the HTML documentation is the most convenient and feature-rich.

The side-bar on the left provides quick navigation.

Code example boxes have two toggle buttons. Clicking on the prompt button >>> hides the prompt and the output. If you then click on the copy icon next to it, you can copy the contents of the box, making it easy to try the code chunks in your Python environment.

[image: toggle_prompt]

A direct link can be obtained for most sections, including the code documentation, by moving the cursor to the right of the text and then clicking on the chain icon. [image: anchor]

When browsing the API documentation and want to look at the implementation, you can easily access the source code by clicking on the [source] tag. [image: source_code]
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How to use the codes

If you want to get to know the classes and functions, the best is to check the API documentation. Most components are amply documented and contain one or more examples. If you want to see them in action, check out our workflow for a real-world application. If you are curious about the underlying algorithms, consult with the Algorithms section.


Tutorials

The tutorials are available in two forms: Python scripts and Jupyter notebooks.


Python scripts

The scripts are intended to be run in batch mode. They need to be run in a specific order as the subsequent scripts rely on the output of the previous ones. These scripts are useful if you are already a bit familiar with CristalX or if you wish to adapt the scripts to your needs. Indeed, if you intend to extend the package, the safest way is to copy the relevant scripts and modify them. The scripts are named as run_moduleName, where moduleName is the name of the module in the grains/ directory that the script mainly relies on. In some way, run_moduleName acts as a demonstration of what the moduleName module is used for. The scripts are meant to be run as modules, i.e. navigate to the root of the project and type

python -m scripts.moduleName








Jupyter notebooks

Almost the same workflow is available as a single Jupyter notebook, located at the nootebooks/ directory. this allows you to interactively discover CristalX through an example. You can easily rerun parts of the code to see the effects of the parameters, and the rich output is embedded into the same document. If you are a novice Python user or just want to have a taste of CristalX, notebooks are the recommended way to get started.






Undo changes

When you experiment with CristalX, you will probably change parameter values. As the scripts communicate by reading and writing data, the original data that come with CristalX will be overwritten. There are multiple ways to undo the changes.


In Binder

As written in the Installation instructions, you can try CristalX online without the need to install anything on your computer. Then a separate virtual environment is created. Whatever changes you make there, they will not influence your local installation (if you have) or the data on the GitHub repository.




In a local installation

If you downloaded CristalX from GitHub, you can simply replace the new files with the original ones. In case you cloned CristalX with Git, you can easily discard the changes you make.
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A detailed workflow

CristalX contains several modules that facilitate experimental and numerical works on polycrystalline microstructures. The usage of these modules is demonstrated on a complex example.



	Problem formulation

	Initial setup

	Identify grains in a microstructure

	Extending the image domain

	From image to geometry

	Repairing the geometry

	Mesh generation

	Modifying the mesh

	Conclusions
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Problem formulation

Grain-based microstructures occur in nature but also develop during industrial processes. We are interested in how the size and the distribution of grains, and the material they are made up of influence the resistance of train wheels and axles to fatigue loading. The problem requires that


	the individual grains can be distinguished on a microscopic image


	a good quality mesh is generated on the microstructure


	the numerical solution obtained on this mesh can be compared to full-field measurements




The first two steps are discussed here.




Initial setup

First, we switch to the root directory of the project so that the package imports are consistent. Note that the relative path always works because the current directory in case of a Jupyter notebook is always the directory in which the notebook is.


[1]:






import os
os.chdir('../')
main_dir = os.path.abspath(os.curdir)







Let us set the directory that will hold our data.


[2]:






data_dir = os.path.abspath('data')
try:
    os.mkdir(data_dir)
except FileExistsError:
    pass







We now copy the necessary data files that come with CristalX into this freshly created directory.


[3]:






from os.path import join
from shutil import copy
selected_files = ['1.png', '1_cropped.png', 'splinegons.png', '1_mesh_extended.npz']
for file in selected_files:
    copy(join('scripts/data', file), data_dir)







In interactive mode, debug information are displayed. They are not useful for presentation purposes as they pollute the rendered output. Similarly for runtime warnings.


[4]:






import logging
logging.basicConfig(level=logging.ERROR)
import warnings
warnings.simplefilter('ignore')







For the figures to be visible in this notebook, we define a utility function to scale them.


[5]:






import matplotlib.pyplot as plt
def scale_figure(dpi):
    plt.gcf().set_dpi(dpi)










Identify grains in a microstructure

The picture below was taken with a digital camera and shows the central part of a tensile specimen. In this section, we will identify the individual grains in the image.


[6]:






from skimage.io import imshow
imshow(join(data_dir, '1.png'))
scale_figure(150)












[image: _images/example_application_13_0.png]




So that the surrounding region does not interfere with the segmentation, we will work on a cropped region.


[7]:






from skimage.io import imread
import numpy as np
image = join(data_dir, '1_cropped.png')







As you can see, the RGB image is represented as a 3D numpy array.


[8]:






image_as_matrix = imread(image)
type(image_as_matrix), image_as_matrix.shape








[8]:







(numpy.ndarray, (638, 589, 3))






However, you do not explicitly have to deal with this matrix as the Segmentation class will handle it.

The Segmentation class offers a set of methods to perform the consecutive steps of the segmentation workflow. We pass to the constructor the path to the image to be segmented. By default, the resulting images are shown at the end of each step. In batch mode, you probably want to set the interactive_mode optional parameter to False. But in this interactive document, we want to see the outputs.


[9]:






from grains.segmentation import Segmentation
GS = Segmentation(image)












[image: _images/example_application_19_0.png]










Image successfully loaded.






After the image has been loaded and stored in the GS object, we want to remove the noise. Since the interfaces among the grains are important for us, we use median filtering for smoothing as it preserves the contours. The smoothing is governed by the window size. The larger this number, the smoother the processed image is, and the higher the computational cost becomes.


[10]:






filter_window_size = 5
filtered = GS.filter_image(filter_window_size)












[image: _images/example_application_21_0.png]










Median filtering finished.






To improve the segmentation result later, we perform superpixel segmentation as an initial step. During this process, the image is subdivided into superpixels, groups of pixels that belong together based on colour, spatial distance or other properties. On this image, a superpixel algorithm called Quick Shift proved to be the best among the algorithms available in scikit-image.


[11]:






segmented = GS.initial_segmentation(filtered)












[image: _images/example_application_23_0.png]










Quick shift segmentation finished. Number of segments: 421






The result is indeed a segmented (also called labelled) image. Distinct positive integers, called labels, are associated to groups of pixels in the labelled image and each pixel belongs to one and only one such group.


[12]:






segmented








[12]:







array([[  8,   8,   8, ...,   2,   2,   2],
       [  8,   8,   8, ...,   2,   2,   2],
       [  8,   8,   8, ...,   2,   2,   2],
       ...,
       [400, 400, 400, ..., 414, 414, 414],
       [400, 400, 400, ..., 414, 414, 414],
       [400, 400, 400, ..., 414, 414, 414]])






The segmented image has the same size as the original image, but it is not an RGB image any more.


[13]:






segmented.shape, image_as_matrix.shape








[13]:







((638, 589), (638, 589, 3))






We can visualize a labelled image by associating different colours to the different labels.


[14]:






from skimage.color import label2rgb
from numpy.random import random
nlabel = len(np.unique(segmented))
imshow(label2rgb(segmented, colors=random((nlabel, 3))))
scale_figure(150)












[image: _images/example_application_29_0.png]




As the superpixel segmentation in the previous step resulted in an oversegmented image, the region adjacency graph is constructed and used to merge some of the neighbouring superpixels based on their similarity with respect to mean colour. Regions connected by edges with smaller weights than a prescribed threshold are combined. As you can see, the number of supersegments decreases.


[15]:






cluster_merging_threshold = 7
reduced = GS.merge_clusters(segmented, threshold=cluster_merging_threshold)












[image: _images/example_application_31_0.png]










Tiny clusters merged. Number of segments: 177






We need a few more steps before succesfully applying another segmentation technique to obtain the final segmented image. First, we detect the grain boundaries. They are shown superposed on the original image.


[16]:






boundary = GS.find_grain_boundaries(reduced)












[image: _images/example_application_33_0.png]










Grain boundaries found.






The boundary image is a binary image in which the True values indicate the boundaries among the labelled regions.


[17]:






boundary








[17]:







array([[False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False],
       ...,
       [False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False],
       [False, False, False, ..., False, False, False]])






The we use thinning on the grain boundary to obtain a single-pixel wide skeleton.


[18]:






skeleton = GS.create_skeleton(boundary)












[image: _images/example_application_37_0.png]










Skeleton constructed.






If the automatic segmentation carried out so far is not good enough, the user can manually edit the skeleton as a graph in ImagePy [https://github.com/Image-Py/imagepy]. The combination of the automatic segmentation with human supervision is a powerful way to achieve good results in a relatively short amount of time. Here, we stay with the automatic method.

To recover the segments again, we use watershed segmentation on the skeleton. Had it been directly applied on the original image, the result of the watershed segmentation would have been an oversegmented image due to the noises that act as local minima. The success of the watershed segmentation depends on how well the catchment basins are identified, which are the locations where the flooding starts. The so-called marker-based watershed segmentation methods rely on markers (computed
automatically or given by the user), i.e. the location of the catchment basins, as inputs. In the watershed_segmentation method of the Segmentation class, various transformations are used to obtain a desirable outcome.


[19]:






watershed = GS.watershed_segmentation(skeleton)












[image: _images/example_application_39_0.png]










Watershed segmentation finished. Number of segments: 247






To the left and to the right of the central zone, artificial “grains” appear. This is not a problem, they can either be merged, or left as it is and associate the same material to them.




Extending the image domain

The segmented image corresponds to the recrystallized part of the specimen. When we perform the traction test numerically we need a larger domain, the boundary on which the boundary conditions are applied. The size of this extended domain does not have to match with the physical size of the tensile specimen, but it has to be sufficiently large so that the far-field boundary conditions do no not influence the deformation state in the central region.

As a first step, we extend the domain by padding the corresponding numpy array. Since we want to handle the added domains (grains) on the left and on the right as separate grains, we associate different labels to them. There are about 250 grains in the central region, so choosing labels 500 and 501 ensures that these regions have unique labels.

The extended domain is constructed in such a way that it matches the region of the DIC measurements. This will be useful when comparing the results of the simulation with the experimental data.


[20]:






from grains.simulation import change_domain
extended_image = change_domain(watershed, 0.4395, 0, 0, 0, 500)
extended_image = change_domain(extended_image, 0, 0.5568, 0, 0, 501)
imshow(extended_image)
scale_figure(150)












[image: _images/example_application_43_0.png]







From image to geometry

In this section, we show how to represent the grains as an explicit geometry. See our paper for the motivation.

For grain representation, we can choose between polygon and splinegon approximations. We will base the meshing on the splinegon representation, but the polygons are also shown. The high-level functions polygonize and splinegonize wrap all the important algorithms. You can see from the code below that they share similar function signature. The only difference is that the spline parameters can be provided to the splinegonize function.


[21]:






from grains.cad import polygonize, search_neighbor, splinegonize
polygons = polygonize(extended_image, search_neighbor(2, np.inf), connectivity=1)
splinegons, _ = splinegonize(extended_image, search_neighbor(2, np.inf), connectivity=1, degree_min=3, degree_max=3, continuity='C0', tol=1)







Let us plot the grains. For polygons:


[22]:






from grains.cad import plot_polygons
plot_polygons(list(polygons.values()));
scale_figure(150)












[image: _images/example_application_48_0.png]




Plotting the spline surfaces will bring up a window.


[23]:






from grains.cad import plot_splinegons
from OCC.Display.SimpleGui import init_display
plot_splinegons(list(splinegons.values()), color=(0, 0, 1))













Layer manager created
Layer dimensions: 1024, 768






To allow reading this document statically, here is a screenshot of the window that popped up.


[24]:






fig, ax = plt.subplots(dpi=500)
imshow(join(data_dir, 'splinegons.png'), ax=ax)
ax.set_axis_off()












[image: _images/example_application_52_0.png]




Once we have the spline surfaces, we write them to a STEP file. This allows us to edit the geometry in a CAD program and to generate a mesh for the grains.


[25]:






from grains.cad import regions2step
regions2step(list(splinegons.values()), join(data_dir, 'microstructure.stp'))










Repairing the geometry

For the sample microstructure, one grain was not identified, i.e. it contains a hole. The hole can be filled in by creating a new grain. We have a detailed guide [https://cristalx.readthedocs.io/en/latest/salome.html] on how to do this.




Mesh generation

The same guide linked in the previous section continues with the mesh generation. It happens that we constructed the conforming mesh in Salome, and then exported it to a .med file. Using the med module [https://cristalx.readthedocs.io/en/latest/api.html#module-grains.med] of CristalX, the triangular mesh cells for each grain and the boundary nodes have been extracted. We also have a tutorial on how to process a .med file [https://cristalx.readthedocs.io/en/latest/med.html].




Modifying the mesh

First, we obtain the mesh data that was saved using the med module.


[26]:






mesh_file = join(data_dir, '1_mesh_extended.npz')
with np.load(mesh_file, allow_pickle=True) as mesh:
    nodes = mesh['nodes']
    elements = mesh['elements']
    element_groups = mesh['element_groups']
    node_groups = mesh['node_groups']
# Retrieve groups, which were stored in dictionaries (https://stackoverflow.com/a/40220343/4892892)
element_groups = element_groups.item()
node_groups = node_groups.item()







The array elements contains the label of the nodes in the mesh.


[27]:






elements








[27]:







array([[  603,   604,  4311],
       [  604,    19,   605],
       [  606,    18,  4312],
       ...,
       [13377, 13369, 13374],
       [13372, 13377, 13373],
       [13373, 13370, 13372]])






The array nodes holds the coordinates of each node of the mesh.


[28]:






nodes








[28]:







array([[2.50000000e-01, 2.59000000e+02],
       [8.00000000e+01, 2.59250000e+02],
       [2.31000000e+02, 2.59250000e+02],
       ...,
       [6.28062814e+02, 8.02235833e+02],
       [6.22855688e+02, 7.95968504e+02],
       [6.23756131e+02, 7.89612749e+02]])






The elements are available for each grain. For instance, grain 87 is labelled as Face_87 and it contains the following elements.


[29]:






element_groups['Face_87']








[29]:







array([23231, 23232, 23233, 23234, 23235, 23236, 23237, 23238, 23239,
       23240, 23241, 23242, 23243, 23244, 23245])






We mentioned earlier that some grains are artefacts of the watershed segmentation. In other words, they are outside the recrystallized central region. Therefore, those grains along with the two extensions (that were given the labels 500 and 501) were merged in Salome and a single mesh was constructed on the merged region. That region contains the most elements.


[30]:






len(element_groups['homogeneous'])








[30]:







3718






To be able to prescribe boundary conditions later, the boundary nodes were also exported from Salome.


[31]:






node_groups








[31]:







{'bottom': array([   8,   14,  448,  452,  467,  468,  470,  471,  472,  474,  475,
         477,  478,  479,  480,  481,  482,  495,  496,  497,  498,  499,
         557,  558,  559,  560,  561,  562,  563,  564,  565, 3673, 3674,
        3675, 3676, 3706, 3707, 3708, 3839, 3840, 3841, 3842, 3851, 3852,
        3861, 3862, 3863, 3864, 3865, 3866, 3867, 3874, 3880, 3881, 3882,
        3883, 3884, 3885, 3886, 3887, 3888, 3895, 3896, 3897, 3914, 3915,
        3922, 3923, 3924, 3925, 3926, 3930, 3931, 3932, 3933, 3943, 3944,
        3945, 3951, 3952, 3953, 3954, 3955, 3956, 3957, 3958, 3959, 3960,
        3961, 3962, 3963, 3964], dtype=int32),
 'left': array([  9,  10, 483, 484, 485, 486, 487, 488, 489, 490, 491, 492, 493,
        494], dtype=int32),
 'right': array([ 15,  16, 545, 546, 547, 548, 549, 550, 551, 552, 553, 554, 555,
        556], dtype=int32),
 'top': array([   0,   11,   17,   20,   21,   25,   28,   33,   34,   36,   44,
          45,   46,   52,   61,   63,  541,  542,  543,  544,  594,  595,
         596,  597,  598,  599,  600,  601,  602,  609,  653,  654,  655,
         656,  673,  674,  675,  676,  677,  678,  679,  702,  703,  704,
         705,  706,  707,  724,  725,  749,  750,  751,  759,  760,  761,
         762,  763,  764,  812,  813,  814,  815,  816,  817,  827,  828,
         829,  830,  831,  832,  848,  849,  850,  851,  896,  897,  898,
         920,  921, 1637, 1638, 1639, 1640], dtype=int32)}






Handling all these data individually is tedious. Hence, we created a mesh class that bundles them and defines operations on them. The TriMesh class is an abstraction for a triangular mesh. First, we initialize it with the elements and the nodes that were loaded from the 1_mesh_extended.npz file.


[32]:






from grains.geometry import TriMesh
mesh = TriMesh(nodes, elements)







The TriMesh class has several options to plot the mesh, for now we consider the default plotting.


[33]:






mesh.plot()
scale_figure(150)












[image: _images/example_application_73_0.png]




Then the element and node sets are associated to the mesh object.


[34]:






# Associate the element and node groups to it
for group_name, elements in element_groups.items():
    mesh.create_cell_set(group_name, elements)
for group_name, nodes in node_groups.items():
    mesh.create_vertex_set(group_name, nodes)







Mesh-based discretization methods often presume that the node ordering within an element is counter-clockwise. To make sure this is the case, we explicitly enforce it.


[35]:






mesh.change_vertex_numbering('ccw', inplace=True);







The mesh was created on the geometry, which was constructed based on the image, i.e. in pixel units. For the simulation to be comparable with the experimental data (full-field measurement), the real size of the tensile speciment must be given. In the first image of this notebook, you can observe a ruler. With the help of it, we set the correspondance between the physical unit and the pixel unit: there are 29.55 pixels in 1 mm.


[36]:






mesh.scale(1/29.55, inplace=True);







For convenience, we rotate the specimen so that its axis is parallel to the horizontal tensile loading.


[37]:






from math import pi
mesh.rotate(-pi/2, inplace=True);







Let us check if this is what we wanted.


[38]:






mesh.plot(vertex_legends=True)
scale_figure(150)












[image: _images/example_application_83_0.png]




We are satisfied with the resulting transformations, so let us save them.


[39]:






np.savez_compressed(join(data_dir, '1_mesh_extended_scaled.npz'),
                    nodes=mesh.vertices, elements=mesh.cells,
                    element_groups=mesh.cell_sets, node_groups=mesh.vertex_sets)










Conclusions

We successfully obtained a good quality mesh starting from an image.

In the near future, we will solve an inverse problem to identify characteristic parameters in the constitutive model. This optimization task requires the comparison of the numerical solution obtained on the mesh with the measured field values acquired through digital image correlation (DIC). Some of this work is already available in the dic and simulation modules.

This document is meant to serve as a global overview of what CristalX can be used for. Feel free to play with the parameters to investigate their effects. The functions and classes of CristalX provide many more functionalities. Browse the documentation [https://cristalx.readthedocs.io/en/latest/] to familiarize yourself with the details.



The initially created directory (data/) is now deleted.


[40]:






from shutil import rmtree
try:
    rmtree(data_dir)
except FileNotFoundError:
    pass
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Geometry and mesh processing in Salome

The cad module, as shown in the Algorithms section, allows to approximate a segmented image with planar spline surfaces (splinegons) and those surfaces can be written to a STEP file. Now, we demonstrate on the sample microstructure how to repair the geometry and generate a conforming mesh on the splinegons. All the manipulations are done in Salome 9.4.0.


Geometry


	Import the geometry
To import a STEP file (obtained by writing the splinegons into a STEP file), select the Geometry module and then File -> Import -> STEP.


	Repair the geometry

For the sample microstructure, one grain has not been identified, i.e. it contains a hole. To fill the hole, we perform the following steps (always select the object that was created the last time):


	Repair -> Close Contour and select the (in our sample) two boundary curves of the unidentified grain.


	Repair -> Suppress Holes and select the two boundary curves you selected in the previous step. Salome informs you that a face will be created in place of the hole.


	Repair -> Limit tolerance and set the tolerance to 1e-3.


	Repair -> Sewing and set 1e-2 for the tolerance.






	Extract the grains
We will need the mesh on each grain, therefore, we extract the grain faces by “exploding” the microstructure using New Entity -> Explode. In the dialog box, select the sewn geometry (end result of the geometry repairing workflow above) as Main Object and Face as Sub-shapes Type. Salome properly identifies the 250 sub-shapes, i.e. the grains.


	Fix the “artificial” grains

The sample microstructure describes the central part of a tensile specimen. However, to adhere to the Saint-Venant principle, the loading is exerted further from this central zone. Hence, we created long enough regions in the direction of the prescribed load by attaching two rectangular faces to the central region. These faces are not precise rectangles because the boundary of the microstructure does not consist of straight segments. Nevertheless, from now on, we will use the term rectangle to describe the extended region. To achieve perfect matching between the rectangle and the boundary of the microstructure, one side of the rectangle must contain the same lines as the boundary of the microstructure. The other three sides will be straight line segments.


	We want to extract the boundary lines of the microstructure. To do that, we explode the boundary grains into edges with New Entity -> Explode. The Main Object in the dialog box is a selected boundary grain, and the Sub-shape Type is Edge. Do this with all the boundary grains.


	Create the three sides of the rectangle


	Create the four vertices of the rectangle with New Entry -> Basic -> Point. Two of these points are the extremities of the microstructure, the other two are given such that


	the rectangle’s three sides become parallel to the coordinate axes (so that boundary conditions are easily prescribed)


	the length of the longer side of the rectangle is long enough compared to the microstructure (we applied a ratio of 5)






	Connect these vertices with three lines, which forms the three sides of the rectangle: New Entity -> Build -> Edge.






	Create the rectangle by connecting the three line segments constructed in the previous step with the boundary lines of the fourth side, obtained by exploding the boundary grains: New Entity -> Build -> Wire.


	Delete the original “artificial” grain as it will be replaced by the new one.


	Create the surface enclosed by the rectangle: New Entity -> Build -> Face, and select the wire created before. Perform steps 1-5 for the other rectangle (on the other side of the microstructure) as well.


	In order to create a conforming mesh on the whole domain (i.e. on the microstructure and on the two rectangles), we need to create a compound surface: New Entity -> Build -> Compound and select the grains plus the two rectangles.


	It is not enough to create the mesh, we also need to know which elements belong to which grains. To allow this, we explode the compound surface: select the compound object created in the previous step as the Main Object in New Entity -> Explode. The Sub-shape Type is Face, as before.








The geometry is now impeccable, let us start meshing.




Mesh

Select the Mesh module.


	Create the mesh


	Choose Mesh -> Create Mesh from the menu. The geometry on which the mesh will be created is the compound surface.


	The mesh type in this study is Triangular and the algorithm is NETGEN 1D-2D. Choose NETGEN 2D Parameters as a hypothesis and experiment with the settings to suit your needs. Accept the changes.


	Choose Mesh -> Compute to generate the mesh with the chosen settings.




If you want to alter the mesh, change the hypothesis and compute the new mesh.



	Obtain the sub-meshes for the grains

The segmented image contains regions that are not part of the recrystallized region, but they belong to the homogeneous region. We want to handle them in the same way as the two artificial grains. We do not need to merge the surfaces, just put them in the same element group. Therefore, we create


	a common element group for the elements lying in the homogeneous region


	one element group for each grain in the heterogeneous (recrystallized) region




using Mesh -> Create Groups from Geometry and selecting all the 250 faces of the geometry. To form a single group for the heterogeneous region, merge the corresponding element groups in Mesh -> Union Groups. Once done, delete the groups that were used in forming the union.



	We will explicitly need to prescribe boundary conditions on the left and right sides of the rectangular domain. For this, the nodes on those sides are collected with Mesh -> Create Group and set the Elements Type to Node. Select the nodes on the left edge and give the node set a name. Repeat it for the nodes on the right.


	Export the mesh
Click on File -> Export -> MED file. The sub-meshes (element groups, node groups) are also exported.




The mesh is ready for further processing. We have another guide that discusses how to handle the MED file from within Python.
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Processing a .med file

After exporting the mesh from Salome to a MED file, we may want to perform certain operations on it. The MEDCoupling [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/index.html] tool of Salome provides C++ and Python APIs for this purpose. However, that requires the user to


	have Salome installed as those APIs are available from the Salome kernel


	get to know the API




Moreover, it can happen that some mesh processing functionalities they may want to use does not exist. Since meshes consisting of cells of the same type (e.g. triangles) can be represented as homogeneous and contiguous arrays, converting the mesh from MED to numpy arrays seems a reasonable choice. This is what our med module does: it provides a thin wrapper around MEDCoupling to extract the mesh and the defined groups (cell and vertex groups) from the MED file and convert them to numpy arrays. This way, the user who deals with numerical modelling can implement their mesh processing algorithms based on numpy arrays, which is fast and straightforward. Furthermore, the person who performs the CAD operations and has Salome installed, can use our med module to export the mesh to numpy arrays so that the numerical analyst can directly work on it without having to have Salome installed and without any knowledge on the MEDCoupling API.

If you want to know more about the implementation details, read the documentation for the med module.


Using the module

To use our med module, access to the MEDLoader module from Salome is required. In the following, we assume that Salome has been installed and added to the path, so the command salome is available. If you


	want to use the Python REPL:

$ salome shell -- python
Python 3.6.5 (default, Dec 16 2019, 16:42:15) 
[GCC 7.3.0] on linux
Type "help", "copyright", "credits" or "license" for more information.





Now, you have access to the MEDCoupling Python API. E.g.

>>> from MEDLoader import MEDFileData







	want to use the PyCharm IDE

$ salome shell "path_to_PyCharm/bin/pycharm.sh"





This will start PyCharm. In the IDE (PyCharm in this example), set the interpreter to that of Salome’s Python. For me, it is located at BINARIES-UB18.04/Python/bin/python3, where UB18.04 refers to the fact that I download [https://www.salome-platform.org/downloads/current-version]ed a pre-compiled Salome binaries for Ubuntu 18.04.





To learn more about the salome command, read the manual [https://docs.salome-platform.org/latest/tui/KERNEL/salome_command.html].
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Algorithms

The goal of this document is to provide more low-level algorithmic details than what is given in our paper. In fact, the material presented here is complimentary to the paper. The paper concentrates on the intuition behind the methods and shows the high-level structure, also citing the relevant literature.


From image to geometry

It is recommended to read Section 2.3 of the paper first and then this section.

The algorithm to construct a geometrical representation out of a segmented image is complex. To reduce the complexity, we created composable parts. We start with some notions below. Then the main steps of the algorithm is discussed in the upcoming subsections.

Grains can have different representations. When represented as an image (input in our algorithm), it is a set of pixels labelled with the same positive integer. A grain can be given different geometrical representations. It can be the assembly of primitive shapes, usually triangles. One can also describe a grain by its boundary. For example, piecewise linear boundary segments lead to a polygon, connecting spline curves lead to a splinegon. A grain can also be represented as a cycle of a graph.

We make distinction between topological and geometrical data. Topological data includes connectivity, neighbourhood and membership information. Coordinates of points are examples for geometrical data. Separating these two terms allows us to build abstractions in the code, making it understandable and extensible.


Skeleton of the image

Based on the segmented/labelled image, skan [https://github.com/jni/skan] builds the skeleton network, as demonstrated on a sample image below. The different pixel colors represent different labels.

[image: skeleton_skan]

As a preprocessing step, we create an additional labelled region that surrounds the original labelled image. The reason is that this way, skan will create branches along the boundary of the original image, which will close the boundary grains. It also simplifies the algorithms we will use later because the boundary interfaces can be handled in the same way as the internal ones: every interface separates exactly two grains.




Which branches form a grain?

The question arises: given the branches, how to reconstruct the grains? First, let us try a graph theoretic approach. In the example below, we want to identify the three grains denoted by roman numerals. The network of branches can be represented as a graph, in which the vertices are the end points and the edges correspond to the branches.

[image: graph_representation]

Adequately selected cycles in this graph would give the grains. However, as discussed in the paper, determining the grains based on the graph exclusively would be very challenging because of the following characteristics.


	For general microstructures, the graph contains multiple edges (see the example above), which rules out many graph processing methods.


	Finding all the elementary cycles in the graph is too costly for graphs coming from realistic microstructures. Even if we found all the cycles, we would need a criterion to choose which ones correspond to grains. E.g. the cycle \( \bar{6}-\bar{2}-\bar{3}-\bar{5} \) does not encompass a single grain but the union of two grains.


	Another technique to find the correct cycles would be the minimum cycle basis. However, this basis is not unique so there is no guarantee that we find the adequate cycles.




The solution is to use both topological and geometrical information. The skeleton is superimposed on the labelled image (from which it was constructed by skan) and the labels around a given skeleton node or end point is detected. Staying with the example in the first subsection, the scheme is shown below.

[image: geom_and_topo]

In the following, we describe an algorithm to find out which two grains are incident to a branch (remember that always two grains neighbor a branch).


Algorithm

The neighbor search around every node of a branch is performed and the two most common labels are chosen. Since in the image representation the grain is a set of pixels having the same label, the selected two labels give the neighboring two grains to a branch.




Neighbor definitions

As described in the paper, certain scenarios necessitate to consider various neighborhood definitions. For those definitions, see the documentation of the grains.utils.neighborhood function.

Going back to the first configuration in the beginning of this section, the algorithm gives the following branch-grain connectivities.


\[\begin{split}\bar{1} &: [\mathrm{I}] \\
\bar{2} &: [\mathrm{II}] \\
\bar{3} &: [\mathrm{I}, \mathrm{II}] \\
\bar{4} &: [\mathrm{III}, \mathrm{II}] \\
\bar{5} &: [\mathrm{I}, \mathrm{III}] \\
\bar{6} &: [\mathrm{II}, \mathrm{I}] \\\end{split}\]

Inverting this relationship gives the grain-branch connectivities:


\[\begin{split}\mathrm{I} &: [\bar{1}, \bar{3}, \bar{5}, \bar{6}] \\
\mathrm{II} &: [\bar{2}, \bar{3}, \bar{6}, \bar{4}] \\
\mathrm{III} &: [\bar{5}, \bar{4}]\end{split}\]

The grain-branch connectivities are an intermediate representation (topological-geometrical). It is independent of how we geometrically represent a grain later.






Grains as oriented planar surfaces

The previous part of the reconstruction algorithm determined which branches bound a grain. In order to obtain a surface representation of a grain, the boundary must be oriented and hence the branches must be connected in the appropriate order. The following figure demonstrates for grain \( \mathrm{II} \) the working of a brute-force algorithm.

[image: orient_boundary]

The branches are interlaced based on their common junctions. The arrows show which branches follow in order. Note that the default orientation of branches \( \bar{3} \) and \( \bar{4} \) needs to be swapped.

Finally, we arrive at a fully geometrical description because each grain is now given by a series of points (nodes and end points) along its boundary.




Geometrical representations of grains

Now that we have a list of points, we can build two geometrical representations of a grain. In the polygon representation, the list of points are the consecutive vertices of the polygon. Their coordinates are stacked, the first vertex being repeated to “close” the polygon. In the spline representation, the list of points on each branch act as a knots of a B-spline. Once the bounding splines have been constructed, the planar spline surface (splinegon) is spanned by those bounding splines.

[image: geometrical_representations]
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Program design

CristalX is not a black-box library such as BLAS, neither is a GUI-based application intended for end-users. It is rather an easy-to-use and extensible set of Python codes that provide the basic functionalities that scientists can extend based on their needs. The following ideas were kept in mind while writing and maintaining CristalX.


	Driven by actual needs




Only implement features that are currently used. Adding extra features requires more testing, possibly more dependencies and therefore code bloat, and increases the cognitive load of the user. Instead, the emphasis is on creating a stable minimum core library that can be easily extended according to users’ demands. Consequently, application code is separated from the core modules.


	Build on well-established packages




We rely on the scientific Python stack: NumPy for array manipulations, SciPy for interpolation and some other computations, Matplotlib for visualization and scikit-image for image processing. This ensures interoperability with other scientific codes and that our software is hopefully bug-free.


	Minimize the dependencies




Rapid prototyping is essential in scientific code development and Python is an excellent choice to satisfy this requirement. At the same time, relying on fast libraries ensures that the computations are reasonably fast. The libraries mentioned in the previous point are easy to install, often already pre-installed in certain Python distributions.


	High-quality documentation




Future contributors will benefit from the rich documentation. Python doctests are extensively used, serving both as test cases and as examples of usage. The docstrings conform to the numpydoc style guide.


	We strive for decoupling the modules




Although part of the grains package, if the modules are independent, they can be reused in other projects too just by copy-pasting the required functions.


	Do not overuse classes




In the prototyping phase, prefer using free functions to methods. As an idea evolves, you will naturally find data and algorithms that belong together, and can refactor free functions into member functions of a class.


	Do not use deep hierarchies




Initially, stay away from excessive nesting to avoid fragmenting the code base. If the project grows big, you can still refactor the code by introducing deeper hierarchies. Deep nesting causes unnecessary cognitive load and it also makes the code more verbose at the caller’s site. Compare

import package1.package2.module





with

import package.module






	Gradually refactor code




As more and more features are added to the project, we will often find that similar tasks emerge in different contexts. It is a good time to think about how they can be generalized and to reconsider your model. This way, you will come up with utility functions best put into utils.py.


	Start writing code only after careful thinking




It is no point in writing code before you completely understand your problem domain you want to model. It is more efficient to build abstractions in your head or on paper, then to split it into modular chunks, and only after that start coding.


	Write the documentation before the code




If you document the function parameters and the return values in advance, as well as construct a doctest, you are enforced to think about the problem deeply and to create a good interface. Moreover, it guarantees that the documentation is not missing (what you would anyway have to write at some point, so why not at the beginning?).


	Give doctest-compatible examples




You hit two birds with the same stone: provide an example for the user and get some confidence that your code works as intended (at least for the particular example). As mentioned in the previous point, write them before the actual code implementation. Doctests do not replace careful testing.


	Keep the documentation as part of your code




The problem with wiki pages is that they are version controlled in a different Git repository. It makes it longer to change a hosting service (e.g. moving from GitHub to GitLab), you need to maintain two repositories, cannot change the documentation and the code in the same commit, and you have to rely on the rendering capabilities of the hosting service (e.g. GitHub cannot render math). It is therefore better to keep the documentation as part of your project in a dedicated directory (docs/ in our case), use a documentation generator (Sphinx in our case) and host it online (on Read the Docs in our case).
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Coding conventions
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Documentation

Writing documentation is necessary when you contribute to this project, either by writing code or by changing/extending the external documents. In this section, we give tips how you can write them. This is an opinionated topic and it lays down how it is currently done. Feel free to suggest new ideas.

Whenever you write the documentation, first test it locally before pushing changes: Read the Docs spends about 1000 seconds to build the documentation.

It took me a long time to experiment with the Sphinx settings that provide the output what you can see in the rendered documentation. Some notes concerning these efforts can be found in the Notes section. Another way to learn about Sphinx documentation is by reading the source of the existing documentation. On each page of the HTML documentation, the header contains a View page source hyperlink.


Code documentation

As shown in the figure, codes are written either as Python files or as Jupyter notebooks. With the proper extensions (see the docs/source/conf.py file), both of them are automatically included in the documentation by Sphinx. In what follows, we concentrate on documenting Python files.

The docstings are written in RST, following the numpydoc [https://numpydoc.readthedocs.io/en/latest/format.html] style, using the Napoleon [https://www.sphinx-doc.org/en/master/usage/extensions/napoleon.html] Sphinx extension.

Provide doctests [https://docs.python.org/3/library/doctest.html] to demonstrate the use of the function you write and to provide minimal testing.

The line length is 100 characters, as defined in the /.editorconfig file.




External documentation

The external documentation is written in reStructuredText (RST) and in Markdown. Sphinx, by default, uses RST, extending it with more capabilities. However, recommonmark [https://github.com/readthedocs/recommonmark] can parse Markdown files and automatically convert them to RST at documentation build time. This is a great help as more people are used to the simple Markdown than to the more complex (and more capable) RST. Actually, the current document you read was also written in Markdown. Of course, it is perfectly fine if you write the documentation exclusively in RST.

Currently, the structure of the documentation is written in RST, and most of the external documentation in Markdown.







          

      

    
        [image: Fork me on GitHub]
    
  
    
    Development
    

    

    

    

    

    

    

    

    

    

    

    

    

    

    
 
  

    

      
          
            
  


Development

Intro …


General workflow

The development workflow can be followed in the following figure.

[image: Alt text]


	You write the Python source codes (.py) and the Jupyter notebooks (.ipynb) on your local machine. If you want, you can create the documentation [https://numpy.org/doc/stable/docs/index.html#documentation] locally using Sphinx.


	When a logical unit has been finished, you commit the changes with git push. This will upload the new version of the modified files to a remote repository (currently GitHub). If you edit files in the remote repository and you want those changes to be present in your local copy, you can use git pull. For more details on Git, read the manual [https://git-scm.com/docs/git-pull].


	Several commit hooks are attached to the remote repository. When they detect a change, certain actions are activated. One the one hand, the online version of the documentation, hosted on Read the Docs [https://cristalx.readthedocs.io/] will be updated. On the other hand, static analyzers will reanalyze the new version of the code. Some of them may create a pull request based on their recommendations.







Profiling

I use Pyinstrument [https://github.com/joerick/pyinstrument] for profiling the code. It comes with the CristalX installation.

Otherwise, you can install it with pip install pyinstrument or by conda after the conda-forge channel has been activated [https://conda-forge.org/docs/user/introduction.html#how-can-i-install-packages-from-conda-forge].

conda install -c conda-forge pyinstrument





As Pyinstrument has no dependencies [https://github.com/joerick/pyinstrument/issues/102], you can safely install it to your current environment. If you do not want to take a risk, create a new environment. With conda, you can do e.g.

conda create -n pyinstrument python=3.7 scipy matplotlib
conda activate pyinstrument
conda install -c conda-forge pyinstrument





The profiling module provides a wrapper around Pyinstrument. Put the code you want to profile in the profile context manager, e.g.

>>> import random
>>> from grains.profiling import profile
>>> with profile('html') as p:
...    for _ in range(1000000):
...        rand_num = random.uniform(1, 2.2)





For more details see the API reference.
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Contributing

CristalX is an open-source project that welcomes contributions of any kind.


What can you help in?

The major fields in which you can help are the following (in increasing complexity).


Use cases

If you use CristalX in your project, let us know. Parts of your code, if they are general enough to be incorporated, could be included in CristalX. Make contact with us by opening an issue.




Documentation

If the documentation of some functions


	is missing


	is incomprehensible


	does not contain examples


	is not rendered properly




or if the code examples break, open a pull request. Similarly, open a pull request if the guides


	contain typos


	are incomprehensible







Code


	You can report bugs by opening an issue.


	If you want to help but do not know where to start, consider the currently open issues [https://github.com/CsatiZoltan/CristalX/issues?q=is%3Aopen+is%3Aissue], especially the ones with the help wanted [https://github.com/CsatiZoltan/CristalX/issues?q=is%3Aopen+is%3Aissue+label%3A%22help+wanted%22] label.


	You can implement new features. First of all, contact us if you plan to work on a non-trivial feature. This will save work for you. Use the fork & PR workflow.









How to contribute

First, create a GitHub account. There are two ways to contribute.


Open an issue

To open a new issue [https://github.com/CsatiZoltan/CristalX/issues/new], click on the green button on the Issues page.

[image: new_issue]




Fork & pull request

At the moment, there are no code formatting guidelines, the best is to follow the formatting of the existing code.


	Fork the GitHub [https://github.com/CsatiZoltan/CristalX] repository by clicking on the Fork button at the top right corner.

[image: fork]



	Install CristalX locally by cloning your fork (git clone).


	Create a new branch.

Do not work on the default (master) branch but create a new feature branch, e.g.

git checkout -b new_feature







	Make your changes.

Add or modify files and regularly commit your changes to your local clone with meaningful commit messages [https://chris.beams.io/posts/git-commit/] (git commit). Do not forget to test your code: if you do not provide unit tests, at least write doctests.



	Push your changes to your remote fork on GitHub (git push).


	Visit your forked repository on GitHub and click on the Pull request button. See the GitHub documentation [https://docs.github.com/en/free-pro-team@latest/github/collaborating-with-issues-and-pull-requests/creating-a-pull-request-from-a-fork] for details.

[image: PR]



	Keep your fork up to date

While you work on your forked repository, changes may be committed to the original (called upstream) repository. To make sure you keep your fork up to date with the upstream repository, follow the instructions in the GitHub documentation [https://docs.github.com/en/free-pro-team@latest/github/collaborating-with-issues-and-pull-requests/syncing-a-fork].





This was a basic overview, for more details check out the following documents:


	https://gist.github.com/Chaser324/ce0505fbed06b947d962


	https://github.com/susam/gitpr
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Versioning

The versioning of CristalX starts with 1.0.0 and it somewhat follows the rules of Semantic Versioning 2.0.0 [https://semver.org/], with the syntax MAJOR.MINOR.PATCH, where MAJOR introduces significant changes, MINOR comes with smaller changes, and PATCH provides a fixture or a tiny improvement either in the code or in the documentation.


Why not SemVer?

Semantic Versioning (SemVer [https://semver.org/]) is a widely used versioning scheme, applicable for public APIs. Its purpose is to be rigorous on how to indicate when a bug fix, new features or incompatible changes in the public API are introduced. There is an excellent discussion about it here [https://gist.github.com/jashkenas/cbd2b088e20279ae2c8e] and a detailed guide here [https://www.jering.tech/articles/semantic-versioning-in-practice]. Many criticize it for not being indicative about the rate of important changes. E.g. 1.8.5 –> 1.9.0 may include dozens of relevant improvements, while 1.9.5 –> 2.0.0 may merely be a simple clean-up that changes the public API. However, SemVer was never meant to be used for software version numbers [https://gist.github.com/jashkenas/cbd2b088e20279ae2c8e#gistcomment-3448638].

CristalX is not a library, but a collection of tools that operate at a high level. Most of its functions are exposed to the user, except the ones marked with a leading underscore or two leading underscores. However, the public API would be a subset of these functions: e.g. the functions of the utils module are exposed but they are mostly intended to be used by other modules, not by the user. As CristalX is not a library but rather a tool for rapid prototyping, semantic versioning would not make much sense.




Why not CalVer?

Calendar Versioning (CalVer [https://calver.org/]) is an alternative to SemVer. CristalX may not come with regular changes in the future or it will get updates at irregular intervals. We do not want to give the impression that relevant changes are introduced linearly in time. Moreover, the changelog and the time stamp in the git commits clearly show when new releases are published.




Our versioning

As there is no unconditionally best versioning system, we came up with our own, which seems to fit well for research code like CristalX. The starting point is SemVer with some differences. Our versioning is intended for humans. The MAJOR version in increased only for substantially new features. This is, of course, subjective but we want to avoid large MAJOR version numbers as e.g. in Firefox. The guideline to follow is that the novelty of a feature makes the MAJOR version increase, not the number of additions. Here are some examples. Assume that we are at 1.2.3. We fixed a set of related bugs in the code: 1.2.3 –> 1.2.4. Then we implemented several functionalities to speed up the code: 1.2.4 –> 1.3.0. A new module was created and several others were modified that allowed us to carry out groundbreaking research: 1.3.0 –> 2.0.0. An existing algorithm was improved to handle the corner cases: 2.0.0 –> 2.1.0.

Similarly to SemVer, when one of the digits increases, the ones right to it are set to zero (e.g. 1.0.1 –> 1.0.2,  1.0.3 –> 1.1.0,  1.8.6 –> 2.0.0).

We try to keep backward compatibility. Insignificant changes are postponed, and are included as part of a MINOR release. If you often feel the need to introduce changes to the function signatures, rather add new functions and give deprecation notices than remove or modify existing ones. This does not lead to code bloat in the long run because deprecated syntax is removed from time to time. To mark a function, a method or a class as deprecated, import the deprecated function from the deprecation package and follow its syntax [https://deprecation.readthedocs.io/en/latest/index.html#deprecation.deprecated].

The master branch of the Git repository contains the latest developments since the last published release. These unreleased modifications are allowed to contain incompatibilities (changes in the function signatures, etc.) compared to the latest release. This flexibility is essential for rapid prototyping in research codes like CristalX. However, these possible incompatibilities must be fixed for the next release, see the previous paragraph.


Connection with the Git workflow

The version numbers are reflected in the tag names. Your normal Git workflow stays the same: commit modifications and push them to the remote repository. When you want to mark a commit yet to be included in a certain version, type

git tag -m "Concise message" v<version_number>





where <version_number> has the form MAJOR.MINOR.PATCH. Note that it is preceded by the v letter, conventionally used for tags. As an example [https://github.com/CsatiZoltan/CristalX/tags]:

git tag -m "Initial release." v1.0.0





Keep the tag message short: the detailed changes since the previous version are collected in the changelog.

The tag is pushed by

git push --tags





Whenever you publish a tag, and hence update the changelog, also create a release [https://github.com/CsatiZoltan/CristalX/releases] for that tag on GitHub. Copy the changes the new version brings from the changelog to the description of the release. In this regard, we follow the way of JabRef [https://github.com/JabRef/jabref/releases]. The zipped size of CristalX is quite small, so size constraint will not be a problem on GitHub [https://docs.github.com/en/free-pro-team@latest/github/managing-large-files/distributing-large-binaries].
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Segmentation

This module contains the Segmentation class, responsible for the image
segmentation of grain-based materials (rocks, metals, etc.)


Classes







	Segmentation

	Segmentation of grain-based microstructures







	
class grains.segmentation.Segmentation(image_location, save_location=None, interactive_mode=True)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Segmentation of grain-based microstructures


	
original_image

	Matrix representing the initial, unprocessed image.


	Type

	ndarray










	
save_location

	Directory where the processed images are saved


	Type

	str [https://docs.python.org/3/library/stdtypes.html#str]










	
create_skeleton(boundary_image)

	Use thinning on the grain boundary image to obtain a single-pixel wide skeleton.


	Parameters

	boundary_image (bool ndarray) – A binary image containing the objects to be skeletonized.



	Returns

	skeleton (bool ndarray) – Thinned image.










	
filter_image(window_size, image_matrix=None)

	Median filtering on an image.
The median filter is useful in our case as it preserves the important
borders (i.e. the grain boundaries).


	Parameters

	
	window_size (int) – Size of the sampling window.


	image_matrix (3D ndarray with size 3 in the third dimension, optional) – Input image to be filtered. If not given, the original image is used.






	Returns

	filtered_image (3D ndarray with size 3 in the third dimension) – Filtered image, output of the median filter algorithm.










	
find_grain_boundaries(segmented_image)

	Find the grain boundaries.


	Parameters

	segmented_image (ndarray) – Label image, output of a segmentation.



	Returns

	boundary (bool ndarray) – A bool ndarray, where True represents a boundary pixel.










	
initial_segmentation(*args)

	Perform the quick shift superpixel segmentation on an image.
The quick shift algorithm is invoked with its default parameters.


	Parameters

	*args (3D numpy array with size 3 in the third dimension) – Input image to be segmented. If not given, the original image is used.



	Returns

	segment_mask (ndarray) – Label image, output of the quick shift algorithm.










	
merge_clusters(segmented_image, threshold=5)

	Merge tiny superpixel clusters.
Superpixel segmentations result in oversegmented images. Based on graph
theoretic tools, similar clusters are merged.


	Parameters

	
	segmented_image (ndarray) – Label image, output of a segmentation.


	threshold (float, optional) – Regions connected by edges with smaller weights are combined.






	Returns

	merged_superpixels (ndarray) – The new labelled array.










	
save_array(filename, array)

	Save an image as a numpy array.
The array is saved in the standard numpy format, into the directory determined by the
save_location attribute.


	Parameters

	
	filename (str) – The array is saved under this name, with extension .npy


	array (ndarray) – An image represented as a numpy array.













	
save_image(filename, array, is_label_image=False)

	Save an image as a numpy array.
The array is saved in the standard numpy format, into the directory determined by the
save_location attribute.


	Parameters

	
	filename (str) – The array is saved under this name, with extension .npy


	array (ndarray) – An image represented as a numpy array.


	is_label_image (bool) – True if the array represents a labeled image.













	
watershed_segmentation(skeleton)

	Watershed segmentation of a granular microstructure.
Uses the watershed transform to label non-overlapping grains in a cellular
microstructure given by the grain boundaries.


	Parameters

	skeleton (bool ndarray) – A binary image, the skeletonized grain boundaries.



	Returns

	segmented (ndarray) – Label image, output of the watershed segmentation.


















Gala

A trimmed version of the Gala project (https://github.com/janelia-flyem/gala)
with some additions (new function, added documentation for the existing ones).
Gala is licensed by the Janelia Farm License:
http://janelia-flyem.github.io/janelia_farm_license.html

Copyright 2012 HHMI. All rights reserved.

Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list
of conditions and the following disclaimer.  Redistributions in binary form must
reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of HHMI nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.


Functions







	imextendedmin(image, h[, connectivity])

	Extended-minima transform.



	hminima(a, thresh)

	Suppress all minima that are shallower than thresh.



	imhmin(a, thresh)

	Suppress all minima that are shallower than thresh.



	morphological_reconstruction(marker, mask[, …])

	Perform morphological reconstruction of the marker into the mask.



	regional_minima(a[, connectivity])

	Find the regional minima in an ndarray.



	complement(a)

	







	
grains.gala_light.complement(a)

	




	
grains.gala_light.hminima(a, thresh)

	Suppress all minima that are shallower than thresh.


	Parameters

	
	a (array) – The input array on which to perform hminima.


	thresh (float) – Any local minima shallower than this will be flattened.






	Returns

	out (array) – A copy of the input array with shallow minima suppressed.










	
grains.gala_light.imextendedmin(image, h, connectivity=1)

	Extended-minima transform.
The extended minima transform is the regional minima of the h-minima transform.
The implementation follows the MATLAB function under the same name.


	Parameters

	
	image (ndarray) – The input array on which to perform imextendedmin.


	h (float) – Any local minima shallower than this will be flattened.


	connectivity (int, optional) – Determines which elements are considered as neighbors of the central
element. Elements up to a squared distance of connectivity from
the center are considered neighbors. If connectivity=1, no diagonal
elements are neighbors.






	Returns

	bool ndarray – True at places of the extended minima.










	
grains.gala_light.imhmin(a, thresh)

	Suppress all minima that are shallower than thresh.


	Parameters

	
	a (array) – The input array on which to perform hminima.


	thresh (float) – Any local minima shallower than this will be flattened.






	Returns

	out (array) – A copy of the input array with shallow minima suppressed.










	
grains.gala_light.morphological_reconstruction(marker, mask, connectivity=1)

	Perform morphological reconstruction of the marker into the mask.

See the Matlab image processing toolbox documentation for details:
http://www.mathworks.com/help/toolbox/images/f18-16264.html






	
grains.gala_light.regional_minima(a, connectivity=1)

	Find the regional minima in an ndarray.
As written in the MATLAB documentation of the imregionalmin function:
“Regional minima are connected components of pixels with a constant
intensity value, surrounded by pixels with a higher value.”










Analysis

This module contains the Analysis class, responsible for the analysis of
segmented grain-based microstructures.

All the examples assume that the modules numpy and matplotlib.pyplot were imported as np
and plt, respectively.


Classes







	Analysis

	Analysis of grain assemblies.









Functions







	feret_diameter(prop)

	Determines the maximum Feret diameter.



	plot_prop(prop[, pixel_per_unit, show_axis])

	Plots relevant region properties into a single figure.



	plot_grain_characteristic(characteristic, …)

	Plots the distribution of a given grain characteristic.



	show_label_image(label_image[, alpha])

	Displays a labeled image.



	label_image_skeleton(label_image)

	Skeleton of a labeled image.



	thicken_skeleton(skeleton, thickness)

	Thickens a skeleton by morphological dilation.



	label_image_apply_mask(label_image, mask, value)

	Changes parts of a labeled image to a given value.







	
class grains.analysis.Analysis(label_image, interactive_mode=False)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

Analysis of grain assemblies.


	
original_image

	Matrix representing the initial, unprocessed image.


	Type

	ndarray










	
save_location

	Directory where the processed images are saved


	Type

	str [https://docs.python.org/3/library/stdtypes.html#str]










	
compute_properties()

	Determines relevant properties of the grains.
The area of each grain is determined in the units previously given in
the set_scale method.


	Parameters

	
	window_size (int) – Size of the sampling window.


	image_matrix (3D ndarray with size 3 in the third dimension, optional) – Input image to be filtered. If not given, the original image is used.






	Returns

	filtered_image (3D ndarray with size 3 in the third dimension) – Filtered image, output of the median filter algorithm.










	
set_scale(pixel_per_unit=1)

	Defines a scale for performing computations in that unit.
Image measures (area, diameter, etc.) are performed on a matrix
corresponding to a label image. Therefore, the result of all the
computations are obtained in pixel units. It is often of interest to
access the results in physical units (mm, cm, inch, etc.). Manually
converting pixels, pixel squares, etc. to pyhsical units, physical unit
sqaures, etc. are tedious and error prone. Once the conversion between
a pixel and a physical unit is given, all the subsequent calculations
are performed in the desired physical unit.


	Parameters

	pixel_per_unit (float or int or scalar ndarray, optional) – Number of pixels contained in a certain unit. The default is 1, in
which case all measurements are performed in pixel units.



	Returns

	None.










	
show_grains(grain_property=None)

	Display the grains, optionally with a property superposed.


	Parameters

	
	grain_property ({None, ‘area’, ‘centroid’, ‘coordinate’,) –               ‘equivalent_diameter’, ‘feret_diameter’, ‘label’}
	optional





If not None, the selected property is shown on the grain as text.



	Returns

	None.










	
show_properties(gui=False)

	Displays previously computed properties of the grains


	Parameters

	gui (bool, optional) – If true, the grain properties are shown in a GUI. If false, they
are printed to stdout. The default is False.
The GUI requires the dfgui modul, which can be obtained from
https://github.com/bluenote10/PandasDataFrameGUI



	Returns

	None.














	
grains.analysis.feret_diameter(prop)

	Determines the maximum Feret diameter.


	Parameters

	prop (RegionProperties) – Describes a labeled region.



	Returns

	max_feret_diameter (float) – Maximum Feret diameter of the region.






See also


	skimage.measure.regionprops() [https://scikit-image.org/docs/stable/api/skimage.measure.html#skimage.measure.regionprops]
	Measure properties of labeled image regions







Examples

>>> import numpy as np
>>> from skimage.measure import regionprops
>>> image = np.ones((2,2), dtype=np.int8)
>>> prop = regionprops(image)[0]
>>> feret_diameter(prop)
2.23606797749979










	
grains.analysis.label_image_apply_mask(label_image, mask, value)

	Changes parts of a labeled image to a given value.

Convenience function, equivalent to label_image[mask] = value but the original array
label_image is not overwritten.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.


	mask (ndarray) – Boolean array of the same size as label_image, marking the pixels that will be
replaced by value.


	value (int) – The masked pixels are replaced by this value.






	Returns

	ndarray – Copy of the input image, its selected pixels being replaced by the given value.










	
grains.analysis.label_image_skeleton(label_image)

	Skeleton of a labeled image.

The skeleton of a labeled image is a single-pixel wide network that separates the labeled
regions.


	Parameters

	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.



	Returns

	ndarray – A 2D bool numpy array having the same size as label_image, where True represents
the skeleton pixels.






See also

thicken_skeleton()








	
grains.analysis.plot_grain_characteristic(characteristic, centers, interpolation='linear', grid_size=(100, 100), **kwargs)

	Plots the distribution of a given grain characteristic.

One way to gain insight into a grain assembly is to plot the distribution of a certain grain
property in the domain the grains occupy. In this function, for each grain, and arbitrary
(scalar) quantity is associated to the center of the grain. In case of n grains, n data
points span the interpolant and the given characteristic is interpolated on a grid of the
AABB of the grain centers.


	Parameters

	
	characteristic (ndarray) – Characteristic property, the distribution of which is sought. A 1D numpy array.


	centers (ndarray) – 2D numpy array with 2 columns, each row corresponding to a grain, and the two columns
giving the Cartesian coordinates of the grain center.


	interpolation ({‘nearest’, ‘linear’, ‘cubic’}, optional) – Type of the interpolation for creating the distribution. The default is ‘linear’.


	grid_size (tuple of int, optional) – 2-tuple, the size of the grid on which the data is interpolated. The default is (100, 100).






	Other Parameters

	
	center_marker (str, optional) – Marker indicating the center of the grains. The default is ‘P’. For a list of supported
markers, see the documentation [https://matplotlib.org/3.2.1/gallery/lines_bars_and_markers/marker_reference.html].
If you do not want the centers to be shown, choose ‘none’.


	show_axis (bool, optional) – If True, the axes are displayed. The default is False.






	Returns

	None






See also

scipy.interpolate.griddata() [https://docs.scipy.org/doc/scipy/reference/reference/generated/scipy.interpolate.griddata.html#scipy.interpolate.griddata]



Notes

This function knows nothing about how the center of a grain is determined and what
characteristic features a grain has. It only performs interpolation and visualization,
hence decoupling the plotting from the actual representation of grains and their
characteristics. For instance, a grain can be represented as a spline surface, as a polygon,
as an assembly of primitives (often triangles), as pixels, just to mention some typical
scenarios. Calculating the center of a grain depends on the grain representation at hand.
Similarly, one can imagine various grain characteristics, such as area, diameter, Young modulus.

Examples

Assume that the grain centers are sampled from a uniformly random distribution on the unit
square.

>>> n_data = 100
>>> points = np.random.random((n_data, 2))





The quantity we want to plot has a parabolic distribution with respect to the position of the
grain centers.

>>> func = lambda x, y: 1 - (x-0.5)**2 - (y-0.5)**2
>>> plot_grain_characteristic(func(points[:, 0], points[:, 1]), points, center_marker='*')
>>> plt.show()










	
grains.analysis.plot_prop(prop, pixel_per_unit=1, show_axis=True)

	Plots relevant region properties into a single figure.
Four subfigures are created, giving the region’s



	image, its area and its center


	filled image, its area


	bounding box, its area


	convex image, its area








	Parameters

	
	prop (RegionProperties) – Describes a labeled region.


	pixel_per_unit (float or int, optional) – Number of pixels contained in a certain unit. The default is 1, in
which case all measurements are performed in pixel units.






	Returns

	fig (matplotlib.figure.Figure) – The figure object is returned in case further manipulations are necessary.










	
grains.analysis.show_label_image(label_image, alpha=1)

	Displays a labeled image.

A random color is associated with each labeled region. If boundary pixels are present in the
image, they are plotted in black.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of non-negative integers.
The label 0 is assumed to denote a boundary pixel.


	alpha (float, optional) – Opacity of colorized labels. Must be within [0, 1].






	Returns

	None










	
grains.analysis.thicken_skeleton(skeleton, thickness)

	Thickens a skeleton by morphological dilation.


	Parameters

	
	skeleton (ndarray) – Skeleton of a binary image, represented as a bool 2D numpy array.


	thickness (int) – Thickness of the resulting boundaries.






	Returns

	ndarray – A 2D bool numpy array, where True represents the thickened skeleton.






See also

label_image_skeleton()












Meshing


Classes







	SkeletonGeometry

	



	QuadSkeletonGeometry

	



	TriSkeletonGeometry

	



	FixedDict

	https://stackoverflow.com/a/14816446/4892892



	OOF2

	







	
class grains.meshing.FixedDict(dictionary)

	Bases: object [https://docs.python.org/3/library/functions.html#object]

https://stackoverflow.com/a/14816446/4892892






	
class grains.meshing.OOF2

	Bases: object [https://docs.python.org/3/library/functions.html#object]


	
create_material(name)

	
	Parameters

	name (TYPE) – DESCRIPTION.



	Raises

	Exception [https://docs.python.org/3/library/exceptions.html#Exception] – DESCRIPTION.



	Returns

	None.










	
create_microstructure(name=None)

	Creates a microstructure from an image.


	Parameters

	name (str, optional) – Path to the image on which the microstucture is created,
file extension included. If not given, the microstructure is given
the same name as the input image.



	Raises

	Exception [https://docs.python.org/3/library/exceptions.html#Exception] – DESCRIPTION.



	Returns

	None.










	
create_skeleton(nelem_x, nelem_y, geometry, name=None)

	




	
load_pixelgroups(microstructure_file)

	
	Parameters

	microstructure_file (str) – DESCRIPTION.



	Returns

	None.










	
materials2groups(materials, groups=None)

	
	Parameters

	
	materials (list of str) – DESCRIPTION.


	groups (list of int, optional) – DESCRIPTION. The default is None.






	Returns

	None.










	
pixel2group()

	




	
read_image(label_image)

	




	
save_microstructure(name=None)

	




	
save_pixelgroups(name=None)

	
	Parameters

	name (str) – DESCRIPTION.



	Returns

	None.










	
script = []

	




	
show()

	
	Returns

	None.










	
write_script(name=None)

	








	
class grains.meshing.QuadSkeletonGeometry(leftright_periodicity=False, topbottom_periodicity=False)

	Bases: grains.meshing.SkeletonGeometry






	
class grains.meshing.SkeletonGeometry(leftright_periodicity, topbottom_periodicity)

	Bases: abc.ABC [https://docs.python.org/3/library/abc.html#abc.ABC]






	
class grains.meshing.TriSkeletonGeometry(leftright_periodicity=False, topbottom_periodicity=False, arrangement='conservative')

	Bases: grains.meshing.SkeletonGeometry






	
grains.meshing.nt

	alias of grains.meshing.modules










CAD

This module contains functions to provide geometrical descriptions of a label image.
Each labelled region is turned to a surface. This allows mesh generators to work on
the geometry instead of an image, thereby creating good quality meshes.

The following functions require PythonOCC version 0.18 to be installed to allow spline
manipulations:


	fit_spline


	branches2splines


	region_as_splinegon


	write_step_file


	regions2step


	plot_splinegons


	splinegonize


	face_area


	subtract


	make_holes





Functions







	build_skeleton(label_image[, connectivity, …])

	Builds skeleton connectivity of a label image.



	skeleton2regions(skeleton_network, …)

	Determines the regions bounded by a skeleton network.



	polygon_orientation(polygon)

	Determines whether a polygon is oriented clockwise or counterclockwise.



	branches2boundary(branches[, orientation])

	Joins connecting branches so that they form the boundary of a surface.



	region_as_polygon(branches[, orientation, close])

	Represents a region as a polygon.



	polygonize(label_image, …[, connectivity, …])

	Polygon representation of a label image.



	branches2splines(branches[, degree_min, …])

	Lays splines on branches.



	fit_spline(points[, degree_min, degree_max, …])

	Approximates a set of points on the plane with a B-spline.



	region_as_splinegon(boundary_splines)

	Represents a region as a splinegon.



	make_holes(splinegons)

	Creates holes for splinegons that contain other splinegons.



	splinegonize(label_image, …[, …])

	Polygon representation of a label image.



	regions2step(splinegons, filename[, …])

	Writes splinegon regions to a STEP file.



	plot_polygons(polygons, **kwargs)

	Plots polygons.



	plot_splinegons(splinegons[, transparency, …])

	Plots splinegons.



	write_step_file(shape, filename[, …])

	Exports a shape to a STEP file.



	plot_polygon(vertices[, ax])

	Plots a polygon.



	overlay_regions(label_image, polygons[, axes])

	Plots a label image, and overlays polygonal regions over it.



	search_neighbor(radius, norm[, method])

	Neighbor search algorithm.



	face_area(face)

	Area of a face.



	subtract(shape1, shape2)

	Boolean difference of two shapes.







	
grains.cad._face_error(error_code)

	Indicates the outcome of the face construction.


	Parameters

	error_code (int) – Error code returned by the Error method of BRepBuilderAPI_MakeFace.



	Returns

	None



	Raises

	ValueError [https://docs.python.org/3/library/exceptions.html#ValueError] – If the error code is 1, 2, 3 or 4. See the OpenCASCADE API:
    https://www.opencascade.com/doc/occt-7.4.0/refman/html/_b_rep_builder_a_p_i___face_error_8hxx.html
    The exception is raised within this function if the face could not be created.










	
grains.cad._spline_continuity_enum(continuity)

	Enumeration value corresponding to the continuity of a B-spline.


	Parameters

	continuity ({‘C0’, ‘G1’, ‘C1’, ‘G2’, ‘C2’, ‘C3’, ‘CN’}) – Continuity of the B-spline.



	Returns

	enum (int) – Integer value corresponding to continuity key in the OpenCASCADE API:
https://www.opencascade.com/doc/occt-7.4.0/refman/html/_geom_abs___shape_8hxx.html










	
grains.cad._wire_error(error_code)

	Indicates the outcome of the wire construction.


	Parameters

	error_code (int) – Error code returned by the Error method of BRepBuilderAPI_MakeWire.



	Returns

	None



	Raises

	ValueError [https://docs.python.org/3/library/exceptions.html#ValueError] – If the error code is 1, 2 or 3. See the OpenCASCADE API:
    https://www.opencascade.com/doc/occt-7.4.0/refman/html/_b_rep_builder_a_p_i___wire_error_8hxx.html
    The exception is raised within this function, as an incompatible wire makes it
    impossible to construct a valid surface.










	
grains.cad.branches2boundary(branches, orientation='ccw')

	Joins connecting branches so that they form the boundary of a surface.

This function assumes that you already know that a set of branches form the boundary of a
surface, but you want to know the ordering. Clockwise or counterclockwise orientation is
supported. A branch is given by its two end points but it can also contain intermediate points
in between, as in the general case. The points on the branches are assumed to be ordered. If
certain branches are not used in forming the boundary of a surface, they are excluded from the
output lists.


	Parameters

	
	branches (list) – Each element of the list gives N>=2 points on the branch, ordered from one end point to the
other. If N=2, the two end points are meant. The points are provided as an Nx2 ndarray,
the first column giving the x, the second column giving the y coordinates of the points.


	orientation ({‘cw’, ‘ccw’}, optional) – Clockwise (‘cw’) or counterclockwise (‘ccw’) orientation of the surface boundary.
The default is ‘ccw’.






	Returns

	
	order (list) – Order of the branches so that they form the boundary of a surface.


	redirected (list) – A list of bool with True value if the orientation of the corresponding branch had to be
swapped to form the surface boundary.


	polygon (ndarray) – The polygon formed by connecting the points of the branches along the boundary. It is given
given as an Mx2 ndarray, where M is the number of unique points on the boundary (i.e. only
one end point is kept for two connecting branches).
This auxiliary data is not essential as it can be restored from the set of branches,
and their ordering. However, it is computed as temporary data needed for determining the
orientation of the boundary.










Examples

>>> import numpy as np
>>> branches = [np.array([[1, 1], [1.5, 2], [2, 3]]), np.array([[1, 1], [-1, 2]]),
... np.array([[1.5, -3], [2, 3]]), np.array([[1.5, -3], [-1, 2]])]
>>> order, redirected, polygon = branches2boundary(branches, orientation='cw')
>>> order
[0, 2, 3, 1]
>>> redirected
[False, True, True, False]
>>> polygon
array([[ 1. ,  1. ],
       [ 1.5,  2. ],
       [ 2. ,  3. ],
       [ 1.5, -3. ],
       [-1. ,  2. ]])










	
grains.cad.branches2splines(branches, degree_min=3, degree_max=8, continuity='C2', tol=0.001)

	Lays splines on branches.


	Parameters

	branches (list) – Each element of the list gives N>=2 points on the branch, ordered from one end point to the
other. If N=2, the two end points are meant. The points are provided as an Nx2 ndarray,
the first column giving the x, the second column giving the y coordinates of the points.



	Other Parameters

	degree_min, degree_max, continuity, tol – See the fit_spline() function.



	Returns

	list – Each member of the list is a Geom_BSplineCurve object, the B-spline approximation of
the corresponding input branch.
For details on the resulting spline, see the OpenCASCADE documentation:
https://www.opencascade.com/doc/occt-7.4.0/refman/html/class_geom___b_spline_curve.html






See also

fit_spline()








	
grains.cad.build_skeleton(label_image, connectivity=1, detect_boundaries=True)

	Builds skeleton connectivity of a label image.

A single-pixel wide network is created, separating the labelled image regions. The resulting
network contains information about how the regions are connected.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.


	connectivity ({1,2}, optional) – A connectivity of 1 (default) means pixels sharing an edge will be considered neighbors.
A connectivity of 2 means pixels sharing a corner will be considered neighbors.


	detect_boundaries (bool, optional) – When True, the image boundaries will be treated as part of the skeleton. This allows
identifying boundary regions in the skeleton2regions function. The default is True.






	Returns

	skeleton_network (Skeleton) – Geometrical and topological information about the skeleton network of the input image.






See also

skan.csr.Skeleton [https://jni.github.io/skan/api/skan.csr.html#skan.csr.Skeleton]








	
grains.cad.face_area(face)

	Area of a face.


	Parameters

	face (TopoDS_Face) – The face for which the area is searched.



	Returns

	float – Area of the face.





Notes

For references, see


	https://dev.opencascade.org/doc/refman/html/class_b_rep_g_prop.html#abd91b892df8d0f6b8571deed5562ca1f


	https://techoverflow.net/2019/06/13/how-to-compute-surface-area-of-topods_face-in-opencascade/


	https://github.com/tpaviot/pythonocc-demos/blob/master/examples/core_shape_properties.py#L48









	
grains.cad.fit_spline(points, degree_min=3, degree_max=8, continuity='C2', tol=0.001)

	Approximates a set of points on the plane with a B-spline.


	Parameters

	
	points (ndarray) – 2D ndarray with N>=2 rows and 2 columns, representing the points on the plane, ordered
from one end point to the other. The first column gives the x, the second column gives the
the y coordinates of the points.


	degree_min (int, optional) – Minimum degree of the spline. The default is 3.


	degree_max (int, optional) – Maximum degree of the spline. The default is 8.


	continuity ({‘C0’, ‘G1’, ‘C1’, ‘G2’, ‘C2’, ‘C3’, ‘CN’}, optional) – The continuity of the spline will be at least continuity. The default is ‘C2’.
For their meanings, consult with
https://www.opencascade.com/doc/occt-7.4.0/refman/html/_geom_abs___shape_8hxx.html


	tol (float, optional) – The distance from the points to the spline will be lower than tol. The default is 1e-3.






	Returns

	spline (Geom_BSplineCurve) – For details on the resulting spline, see the OpenCASCADE documentation:
https://www.opencascade.com/doc/occt-7.4.0/refman/html/class_geom___b_spline_curve.html



	Raises

	ValueError [https://docs.python.org/3/library/exceptions.html#ValueError] – If the minimum degree of the B-spline to be constructed is greater than its maximum degree.










	
grains.cad.make_holes(splinegons)

	Creates holes for splinegons that contain other splinegons.

When a smaller splinegon is embedded to a larger one, the boundary of the larger splinegon
does not describe it properly. The smaller splinegons have to be subtracted to reproduce the
non-simply connected domain. As an analogy to material science, the intended application of
this module, we will use the term matrix for the larger grain and inclusion for the
smaller one. This function handles multiple inclusion in a matrix and should be called after
the splinegon regions have been constructed. No need to directly call make_holes() if
you use the splinegonize() utility function.


Todo

Implement it more generally, see the related issue [https://github.com/CsatiZoltan/CristalX/issues/37].




	Parameters

	splinegons (dict) – The keys in the dictionary correspond to the labels of the input image, while the values
are TopoDS_Face objects, the surfaces of the regions.



	Returns

	splinegons (dict) – The input dictionary modified such that the inclusions are removed from the matrix.










	
grains.cad.overlay_regions(label_image, polygons, axes=None)

	Plots a label image, and overlays polygonal regions over it.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.


	polygons (dict) – The keys in the dictionary correspond to the labels of the input image, while the values
are ndarray objects with two columns, the x and y coordinates of the polygons.
This format is respected by the output of the polygonize function.


	axes (matplotlib.axes.Axes, optional) – An Axes object on which to draw. If None, a new one is created.






	Returns

	axes (matplotlib.axes.Axes) – The Axes object on which the plot is drawn.






See also

polygonize(), matplotlib.collections.LineCollection [https://matplotlib.org/api/collections_api.html#matplotlib.collections.LineCollection]








	
grains.cad.plot_polygon(vertices, ax=None, **kwargs)

	Plots a polygon.


	Parameters

	
	vertices (ndarray) – 2D ndarray of size Nx2, with each row designating a vertex and the two columns
giving the x and y coordinates of the vertices, respectively.


	ax (matplotlib.axes.Axes, optional) – The Axes instance the polygon is plotted into. The default is None, in which case a new
Axes within a new figure is created.


	**kwargs (Line2D properties, optional) – Keyword arguments accepted by matplotlib.pyplot.plot






	Returns

	None






See also

matplotlib.pyplot.plot() [https://matplotlib.org/api/_as_gen/matplotlib.pyplot.plot.html#matplotlib.pyplot.plot]



Examples

>>> plot_polygon(np.array([[1, 1], [2, 3], [1.5, -3], [-1, 2]]), marker='o');  plt.show()










	
grains.cad.plot_polygons(polygons, **kwargs)

	Plots polygons.


	Parameters

	polygons (list) – Each member of the list is a 2D numpy array with 2 columns, each row corresponding to a
vertex of the polygon, and the two columns giving the Cartesian coordinates of the vertices.



	Other Parameters

	kwargs (optional) – Keyword arguments supported by the constructor of the matplotlib.figure.Figure [https://matplotlib.org/api/figure_api.html#matplotlib.figure.Figure]
class.



	Returns

	fig (matplotlib.figure.Figure) – Figure the polygons are plotted into.






See also

polygonize()








	
grains.cad.plot_splinegons(splinegons, transparency=0.5, color='random')

	Plots splinegons.


	Parameters

	
	splinegons (list) – Each member of the list is a TopoDS_Face object, the surface of a splinegon.


	transparency (float, optional) – The transparency value should be between 0 and 1. At 0, an object will be totally opaque,
and at 1, fully transparent.


	color (tuple or str, optional) – Color of the splinegons. Either ‘random’ to associate a random color for each splinegon
in the list splinegons or a 3-tuple with entries between 0 and 1 to give the same RGB
values to all the splinegons.






	Returns

	None






See also

splinegonize()








	
grains.cad.polygon_orientation(polygon)

	Determines whether a polygon is oriented clockwise or counterclockwise.


	Parameters

	polygon (list) – Each element of the list denotes a vertex of the polygon and in turn is another list of two
elements: the x and y coordinates of a vertex.



	Returns

	orientation ({‘cw’, ‘ccw’}) – ‘cw’: clockwise, ‘ccw’: counterclockwise orientation





Notes

The formula to determine the orientation is from https://stackoverflow.com/a/1165943/4892892.
For simple polygons (polygons that admit a well-defined interior), a faster algorithm exits, see
https://en.wikipedia.org/wiki/Curve_orientation#Orientation_of_a_simple_polygon.

Examples

>>> polygon = [[5, 0], [6, 4], [4, 5], [1, 5], [1, 0]]
>>> polygon_orientation(polygon)
'ccw'










	
grains.cad.polygonize(label_image, neighbor_search_algorithm, connectivity=1, detect_boundaries=True, orientation='ccw', close=False)

	Polygon representation of a label image.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.


	neighbor_search_algorithm (functools.partial) – Specifies which algorithm to use for constructing the branch-region connectivity.
The function to be passed (along with its arguments) is skeleton2regions().


	connectivity ({1,2}, optional) – A connectivity of 1 (default) means pixels sharing an edge will be considered neighbors.
A connectivity of 2 means pixels sharing a corner will be considered neighbors.


	detect_boundaries (bool, optional) – When True, the image boundaries will be treated as part of the skeleton. This allows
identifying boundary regions in the skeleton2regions function. The default is True.


	orientation ({‘cw’, ‘ccw’}, optional) – Clockwise (‘cw’) or counterclockwise (‘ccw’) orientation of the polygons.
The default is ‘ccw’.


	close (bool, optional) – When True, one vertex in the polygons is repeated to indicate that the polygons are
indeed closed. The default is False.






	Returns

	polygons (dict) – The keys in the dictionary correspond to the labels of the input image, while the values
are ndarray objects with two columns, the x and y coordinates of the polygons.






See also

build_skeleton(), skeleton2regions(), region_as_polygon()



Examples

>>> test_image = np.array([
...   [1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3]],
...  dtype=np.int8)
>>> polygons = polygonize(test_image, search_neighbor(2, np.inf), connectivity=1)










	
grains.cad.region_as_polygon(branches, orientation='ccw', close='False')

	Represents a region as a polygon.

Based on the combined topological-geometrical (intermediate) representation of the regions,
(done by skeleton2regions()), this function provides a fully geometrical description
of a region.


	Parameters

	
	branches (list) – Each element of the list gives N>=2 points on the branch, ordered from one end point to the
other. If N=2, the two end points are meant. The points are provided as an Nx2 ndarray,
the first column giving the x, the second column giving the y coordinates of the points.
The branches are not necessarily ordered.


	orientation ({‘cw’, ‘ccw’}, optional) – Clockwise (‘cw’) or counterclockwise (‘ccw’) orientation of the polygons.
The default is ‘ccw’.


	close (bool, optional) – When True, one vertex in the polygons is repeated to indicate that the polygons are
indeed closed. The default is False.






	Returns

	polygon (ndarray) – The resulting polygon, given as an Mx2 ndarray, where M is the number of unique points on
the polygon (i.e. only one end point is kept for two connecting branches).






See also

skeleton2regions()








	
grains.cad.region_as_splinegon(boundary_splines)

	Represents a region as a splinegon.

Based on the combined topological-geometrical (intermediate) representation of the regions,
(done by skeleton2regions()), this function provides a fully geometrical description
of a region.


	Parameters

	boundary_splines (list) – Each element of the list is a Handle_Geom_BSplineCurve object, giving a reference to the
B-splines bounding the region. The splines must either be ordered (see
branches2boundary()) or they must appear in an order such that the n-th spline in
the list can be connected to one of the first n-1 splines in the list.



	Returns

	
	splinegon (TopoDS_Face) – The resulting splinegon (surface). For details on the object, see the OpenCASCADE API:
https://www.opencascade.com/doc/occt-7.4.0/refman/html/class_topo_d_s___face.html


	boundary (TopoDS_Wire) – The boundary of the splinegon. For details on the resulting object, see the OpenCASCADE API:
https://www.opencascade.com/doc/occt-7.4.0/refman/html/class_topo_d_s___wire.html











See also

skeleton2regions(), fit_spline()



Notes

The syntax Handle_classname in PythonOCC corresponds to wrapping the object of class
classname with a smart pointer. In the C++ interface, it is done by a template:
Handle<classname>.






	
grains.cad.regions2step(splinegons, filename, application_protocol='AP203')

	Writes splinegon regions to a STEP file.


	Parameters

	
	splinegons (list) – Each member of the list is a TopoDS_Face object, the surface of a region.


	filename (str) – Name of the file the regions are saved into.


	application_protocol ({‘AP203’, ‘AP214IS’, ‘AP242DIS’}, optional) – Version of schema used for the output STEP file. The default is ‘AP203’.






	Returns

	None






See also

splinegonize(), write_step_file()








	
grains.cad.search_neighbor(radius, norm, method='sphere')

	Neighbor search algorithm.


	Parameters

	radius, norm, method – See the grains.utils.neighborhood() function.



	Returns

	functools.partial – A new function with partial application of the given input arguments on the
grains.utils.neighborhood() function. The returned partial function is used
internally by skeleton2regions() when performing neighbor searching.






See also

grains.utils.neighborhood(), skeleton2regions()








	
grains.cad.skeleton2regions(skeleton_network, neighbor_search_algorithm)

	Determines the regions bounded by a skeleton network.

This function can be perceived as an intermediate step between a skeleton network and
completely geometrical representation of the regions. That is, it keeps the key topological
information required to create a fully geometrical description, but it also contains the
coordinates of the region boundaries. The outputs of this function can be used to build
different region representations.


	Parameters

	
	skeleton_network (Skeleton) – Geometrical and topological information about the skeleton network of a label image.


	neighbor_search_algorithm (functools.partial) – Specifies which algorithm to use for constructing the branch-region connectivity.
The function to be passed (along with its arguments) is search_neighbor().
For further details, see the Notes below.






	Returns

	
	region_branches (dict) – For each region it contains the branch indices that bound that region.


	branch_coordinates (list) – Coordinates of the points on each branch.


	branch_regions (dict) – For each branch it contains the neighboring regions.
This auxiliary data is not essential as it can be restored from region_branches.
However, it is computed as temporary data needed for region_branches.











See also

build_skeleton(), search_neighbor(), overlay_regions()



Notes

Although the algorithms were created to require minimum user intervention, some parameters
must be fine-tuned so as to achieve an optimal result in identifying the regions. Visualization
plays an important role in it. Full automation is either not possible or would require a huge
computational cost. The shortcoming of the algorithms in this function is the following.
The recognition of which branches form a region is based on the premise that a node of a branch
belongs to a region if its n-pixel neighbourhood contains a pixel from that region. Ideally,
n=1 would be used, meaning that the single-pixel width skeleton is located at most 1 pixel
afar from the regions it lies among. This is true but the nodes of the skeleton can be farther
than 1 pixel from a region. Hence, n has to be a parameter of our model. Increasing n helps
in identifying the connecting regions to a node of a branch. On the other hand, if n is too
large, regions that “in reality” are not neighbors of a branch will be included. Currently, we
recommend trying different parameters n, plot the reconstructed regions over the label image
using the overlay_regions() function, and see how good the result is. As a heuristic,
start with n=2.






	
grains.cad.splinegonize(label_image, neighbor_search_algorithm, connectivity=1, detect_boundaries=True, degree_min=3, degree_max=8, continuity='C2', tol=0.0001)

	Polygon representation of a label image.


	Parameters

	
	label_image (ndarray) – Labeled input image, represented as a 2D numpy array of positive integers.


	neighbor_search_algorithm (functools.partial) – Specifies which algorithm to use for constructing the branch-region connectivity.
The function to be passed (along with its arguments) is skeleton2regions().


	connectivity ({1,2}, optional) – A connectivity of 1 (default) means pixels sharing an edge will be considered neighbors.
A connectivity of 2 means pixels sharing a corner will be considered neighbors.


	detect_boundaries (bool, optional) – When True, the image boundaries will be treated as part of the skeleton. This allows
identifying boundary regions in the skeleton2regions function. The default is True.






	Other Parameters

	degree_min, degree_max, continuity, tol – See the fit_spline() function.



	Returns

	
	splinegons (dict) – The keys in the dictionary correspond to the labels of the input image, while the values
are TopoDS_Face objects, the surfaces of the regions.


	boundaries (dict) – The keys in the dictionary correspond to the labels of the input image, while the values
are TopoDS_Wire objects, the boundaries of the regions.











See also

build_skeleton(), skeleton2regions(), region_as_splinegon()



Examples

>>> test_image = np.array([
...   [1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [1, 1, 1, 1, 1, 1, 1, 1, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3],
...   [2, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3, 3]],
...  dtype=np.int8)
>>> splinegons, _ = splinegonize(test_image, search_neighbor(2, np.inf), connectivity=1, tol=0.1)
>>> plot_splinegons(list(splinegons.values()))










	
grains.cad.subtract(shape1, shape2)

	Boolean difference of two shapes.


	Parameters

	shape1, shape2 (TopoDS_Shape) – Surfaces.



	Returns

	difference (TopoDS_Shape) – The set difference shape1 \ shape2.





Notes

The implementation follows the following sources:


	https://techoverflow.net/2019/06/14/how-to-fuse-topods_shapes-in-opencascade-boolean-and/


	https://github.com/tpaviot/pythonocc-demos/blob/master/examples/core_boolean_fuzzy_cut_emmenthaler.py#L41-L54




For Boolean operations in Open CASCADE, see its documentation [https://dev.opencascade.org/doc/overview/html/specification__boolean_operations.html].






	
grains.cad.write_step_file(shape, filename, application_protocol='AP203')

	Exports a shape to a STEP file.


	Parameters

	
	shape (TopoDS_Shape) – Shape to be exported, an object of the TopoDS_Shape class or one of its subclasses. See
https://www.opencascade.com/doc/occt-7.4.0/refman/html/class_topo_d_s___shape.html


	filename (str) – Name of the file the shape is saved into.


	application_protocol ({‘AP203’, ‘AP214IS’, ‘AP242DIS’}, optional) – Version of schema used for the output STEP file. The default is ‘AP203’.








Notes

For details on how to read and write STEP files, see the documentation on
https://dev.opencascade.org/doc/overview/html/occt_user_guides__step.html.










MED

Extracting and processing meshes from .med files.
The functions were tested on the MEDCoupling API, version 9.4.0.


Todo

Support renumbering (https://docs.salome-platform.org/latest/dev/MEDCoupling/user/html/data_optimization.html).



Getting help:


	This module relies on the Python interface of MEDCoupling. Click here [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/index.html] for the latest documentation.


	User’s manual [https://docs.salome-platform.org/latest/dev/MEDCoupling/user/html/index.html] for the Python interface


	To know more about the MED file format, which is a specialization of HDF5, see the documentation [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/med-file.html].
For a discussion on the relation between the MED format and the APIS, see this page [https://www.salome-platform.org/user-section/about/med] and that one [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/library.html].


	The definitions, such as group, used in this module are from the development guide [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/glossary.html].


	A (mostly English) tutorial [https://docs.salome-platform.org/latest/dev/MEDCoupling/tutorial/index.html] for the Python interface to MEDCoupling is also useful.
Particularly interesting are the mesh manipulation examples [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/medcouplingpyexamples.html#ExamplesMeshes]


	Main page [https://salome-platform.org/user-section/documentation/current-release] of the documentation





Functions







	read_mesh

	Reads a mesh file in .med format.



	get_nodes

	Obtains the nodes and the node groups of a mesh.



	get_elements

	Obtains the elements for each group of a mesh.







	
grains.med.get_elements(mesh, numbering='global')

	Obtains the elements for each group of a mesh.

Elements of the same dimension as the mesh are collected (e.g. faces for a 2D mesh).


Todo

put those elements that do not belong to any group into an automatically created group




Todo

support ordering elements in alphabetical order




Todo

implement the ‘global’ strategy




	Parameters

	
	mesh (MEDFileUMesh) – Unstructured mesh.


	numbering ({‘global’}, optional) –


	Determines how to allocate element numbers in the mesh.
	‘global’: numbers the elements without taking into account which group they belong to.
Use this strategy if you are not sure whether an element belongs to more than one group.
‘group’: numbers the elements group-wise. This is much faster than the ‘global’
strategy, but use this option if you are sure that the groups of the mesh do not
contain common elements.





The default is ‘global’.







	Returns

	
	elements (ndarray) – Element-node connectivities in a 2D numpy array, in which each row corresponds to an
element and the columns are the nodes of the elements. It is assumed that all the
elements have the same number of nodes.


	element_groups (dict) – The keys in the dictionary are the element group names, while the values are list of
integers, giving the elements that belong to the particular group.











Warning

Currently, elements that do not fit into any groups are discarded.




See also

get_nodes(), change_node_numbering()



Notes

The element-node connectivities are read from the mesh. If you want to change the ordering
of the nodes, use the change_node_numbering() function.

Both this and the get_nodes() function relies on getGroupsOnSpecifiedLev [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/classMEDCoupling_1_1MEDFileMesh.html#a2d59097b6d14b95c7d2aeee9f39b0438] to obtain the groups
based on a parameter, called meshDimRelToMaxExt. This parameter designates the relative
dimension of the mesh entities whose IDs are required. If it is 1, it denotes the nodes. If
0, entities of the same dimension as the mesh are meant (e.g. group of volumes for a 3D mesh,
or group of faces for a 2D mesh). When -1, entities of spatial dimension immediately below
that of the mesh are collected (e.g. group of faces for a 3D mesh, or group of edges for a
2D mesh). For -2, entities of two dimensions below that of the mesh are fetched (e.g. group of
edges for a 3D mesh).






	
grains.med.get_nodes(mesh)

	Obtains the nodes and the node groups of a mesh.


	Parameters

	mesh (MEDFileUMesh) – Unstructured mesh.



	Returns

	
	nodes (ndarray) – 2D numpy array with 2 columns, each row corresponding to a node, and the two columns
giving the Cartesian coordinates of the nodes.


	node_groups (dict) – The keys in the dictionary are the node group names, while the values are list of integers,
giving the nodes that belong to the particular group.











See also

get_elements(),
getGroupArr [https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/classMEDCoupling_1_1MEDFileMesh.html#a4398c05f015e52d0d380eb39c6e4b942]








	
grains.med.read_mesh(filename)

	Reads a mesh file in .med format.
Only one mesh, the first one, is supported. However, that mesh can contain groups.


	Parameters

	filename (str) – Path to the mesh file.



	Returns

	MEDFileUMesh – Represents an unstructured mesh. For details, see the manual on
https://docs.salome-platform.org/latest/dev/MEDCoupling/developer/classMEDCoupling_1_1MEDFileUMesh.html














Geometry

This module implements computational geometry algorithms, needed for other modules.

All the examples assume that the modules numpy and matplotlib.pyplot were imported as np
and plt, respectively.


Classes







	Mesh

	Data structure for a general mesh.



	TriMesh

	Unstructured triangular mesh.



	Polygon

	Represents a polygon.









Functions







	is_collinear(points[, tol])

	Decides whether a set of points is collinear.



	squared_distance(x, y)

	Squared Euclidean distance between two points.



	distance_matrix(points)

	A symmetric square matrix, containing the pairwise squared Euclidean distances among points.



	_polygon_area(x, y)

	Computes the signed area of a non-self-intersecting, possibly concave, polygon.







	
class grains.geometry.Mesh(vertices, cells)

	Bases: abc.ABC [https://docs.python.org/3/library/abc.html#abc.ABC]

Data structure for a general mesh.

This class by no means wants to provide intricate functionalities and does not strive to be
efficient at all. Its purpose is to give some useful features the project relies on.
The two main entities in the mesh are the vertices and the cells. They are expected to be
passed by the user, so reading from various mesh files is not implemented. This keeps the
class simple, requires few package dependencies and keeps the class focused as there are
powerful tools to convert among mesh formats (see e.g. meshio [https://github.com/nschloe/meshio]).


	Parameters

	
	vertices (ndarray) – 2D numpy array with 2 columns, each row corresponding to a vertex, and the two columns
giving the Cartesian coordinates of the vertex.


	cells (ndarray) – Cell-vertex connectivities in a 2D numpy array, in which each row corresponds to a
cell and the columns are the vertices of the cells. It is assumed that all the cells
have the same number of vertices.









See also

change_vertex_numbering



Notes

Although not necessary, it is highly recommended that the local vertex numbering in the
cells are the same, either clockwise or counter-clockwise. Some methods, such as
get_boundary() even requires it. If you are not sure whether the cells you provide
have a consistent numbering, it is better to renumber them by calling the
change_vertex_numbering() method.


	
static _ismatrix(array)

	Decides whether the input is a matrix.


	Parameters

	array (ndarray) – Numpy array to be checked.



	Returns

	bool – True if the input is a 2D array. Otherwise, False.






See also

_isvector()








	
static _isvector(array)

	Decides whether the input is a vector.


	Parameters

	array (ndarray) – Numpy array to be checked.



	Re